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				Introduction

				What? Yet another statistics book? Well . . . this is a statistics book, all right, but in my humble (and thoroughly biased) opinion, it’s not just another statistics book. 

				What? Yet another Excel book? Same thoroughly biased opinion — it’s not just another Excel book. What? Yet another edition of a book that’s not just another statistics book and not just another Excel book? Well . . . yes. You got me there.

				So here’s the deal — for the previous edition and for this one. Many statistics books teach you the concepts but don’t give you a way to apply them. That often leads to a lack of understanding. With Excel, you have a ready-made package for applying statistics concepts. 

				Looking at it from the opposite direction, many Excel books show you Excel’s capabilities but don’t tell you about the concepts behind them. Before I tell you about an Excel statistical tool, I give you the statistical foundation it’s based on. That way, you understand the tool when you use it — and you use it more effectively. 

				I didn’t want to write a book that’s just “select this menu” and “click this button.” Some of that is necessary, of course, in any book that shows you how to use a software package. My goal was to go way beyond that.

				I also didn’t want to write a statistics “cookbook”: When-faced-with-problem-#310-use-statistical-procedure-#214. My goal was to go way beyond that, too.

				Bottom line: This book isn’t just about statistics or just about Excel — it sits firmly at the intersection of the two. In the course of telling you about statistics, I cover every Excel statistical feature. (Well . . . almost. I left one out. I left it out of the first edition, too. It’s called “Fourier Analysis.” All the necessary math to understand it would take a whole book, and you might never use this tool, anyway.)

				About This Book

				Although statistics involves a logical progression of concepts, I organized this book so you can open it up in any chapter and start reading. The idea is for you to find what you’re looking for in a hurry and use it immediately — whether it’s a statistical concept or an Excel tool. 

				On the other hand, cover to cover is okay if you’re so inclined. If you’re a statistics newbie and you have to use Excel for statistical analysis, I recommend you begin at the beginning — even if you know Excel pretty well.

				What You Can Safely Skip

				Any reference book throws a lot of information at you, and this one is no exception. I intended it all to be useful, but I didn’t aim it all at the same level. So if you’re not deeply into the subject matter, you can avoid paragraphs marked with the Technical Stuff icon.

				Every so often, you’ll run into sidebars. They provide information that elaborates on a topic, but they’re not part of the main path. If you’re in a hurry, you can breeze past them.

				Because I wrote this book so you can open it up anywhere and start using it, step-by-step instructions appear throughout. Many of the procedures I describe have steps in common. After you go through some of the procedures, you can probably skip the first few steps when you come to a procedure you haven’t been through before.

				Foolish Assumptions

				This is not an introductory book on Excel or on Windows, so I’m assuming:

				You know how to work with Windows. I don’t go through the details of pointing, clicking, selecting, and so forth.

				You have Excel installed on your computer and you can work along with the examples. I don’t take you through the steps of Excel installation. Incidentally, I use Excel 2007 (running in Windows Vista). If you’re using Excel 97, Excel 2000, or Excel 2003, that’s okay. The statistical functionality is the same. Some of the screen shots in the book will look a little different from what appears on your computer, however. 

				 Also, Excel 2007 has an entirely new user interface, so getting to the statistical functionality is somewhat different from previous versions.

				You’ve worked with Excel before, and you understand the essentials of worksheets and formulas.

				If you don’t know much about Excel, consider looking into Greg Harvey’s excellent Excel books in the For Dummies series. His latest work covers Excel 2007.

				How This Book Is Organized

				I organized this book into five parts and three appendixes. 

				Part I: Statistics and Excel: A Marriage Made in Heaven

				In Part I, I provide a general introduction to statistics and to Excel’s statistical capabilities. I discuss important statistical concepts and describe useful Excel techniques. If it’s a long time since your last course in statistics or if you never had a statistics course at all, start here. If you haven’t worked with Excel’s built-in functions (of any kind) definitely start here. 

				Part II: Describing Data

				Part of statistics is to take sets of numbers and summarize them in meaningful ways. Here’s where you find out how to do that. We all know about averages and how to compute them. But that’s not the whole story. In this part, I tell you about additional statistics that fill in the gaps, and I show you how to use Excel to work with those statistics. I also introduce Excel graphics in this part.

				Part III: Drawing Conclusions from Data

				Part III addresses the fundamental aim of statistical analysis: to go beyond the data and help decision-makers make decisions. Usually, the data are measurements of a sample taken from a large population. The goal is to use these data to figure out what’s going on in the population. 

				This opens a wide range of questions: What does an average mean? What does the difference between two averages mean? Are two things associated? These are only a few of the questions I address in Part III, and I discuss the Excel functions and tools that help you answer them.

				Part IV: Working with Probability

				Probability is the basis for statistical analysis and decision-making. In Part IV, I tell you all about it. I show you how to apply probability, particularly in the area of modeling. Excel provides a rich set of built-in capabilities that help you understand and apply probability. Here’s where you find them. 

				Part V: The Part of Tens

				Part V meets two objectives. First, I get to stand on the soapbox and rant about statistical peeves and about helpful hints. The peeves and hints total up to ten. Also, I discuss ten (okay, twelve) Excel things I couldn’t fit in any other chapter. They come from all over the world of statistics. If it’s Excel and statistical, and if you can’t find it anywhere else in the book, you’ll find ithere. 

				As I said in the first edition — pretty handy, this Part of Tens.

				Appendix A: When Your Worksheet Is a Database

				In addition to performing calculations, Excel serves another purpose: record-keeping. Although it’s not a dedicated database, Excel does offer some database functions. Some of them are statistical in nature. I introduce Excel database functions in Appendix A, along with pivot tables that allow you to turn your database inside out and look at your data in different ways.

				Appendix B: The Analysis of Covariance

				This is new in this edition. The Analysis of Covariance (ANCOVA) is a statistical technique that combines two other techniques — analysis of variance and regression analysis. If you know how two variables are related, you can use that knowledge in some nifty ways, and this is one of the ways. The kicker is that Excel doesn’t have a built-in tool for ANCOVA — but I show you how to use what Excel does have so you can get the job done. 

				Appendix C: Of Stems, Leaves, Boxes, Whiskers, and Smoothies

				This is another addition to this edition. Statisticians often use special techniques to explore and visualize data, and Appendix C covers some of those techniques. They’re not built into Excel. As is the case with ANCOVA, however, I show you how to use Excel’s capabilities to implement them.

				Icons Used in This Book

				As is the case with all For Dummies books, icons appear all over. Each one is a little picture in the margin that lets you know something special about the paragraph it’s next to.

				[image: Tip.eps] This icon points out a hint or a shortcut that helps you in your work and makes you an all-around better human being.

				[image: Remember.eps] This one points out timeless wisdom to take with you long after you finish this book, grasshopper.

				[image: Warning(bomb).eps] Pay attention to this icon. It’s a reminder to avoid something that might gum up the works for you.

				[image: TechnicalStuff.eps] As I mentioned in “What You Can Safely Skip,” this icon indicates material you can blow past if statistics and Excel aren’t your passion. 

				Where to Go from Here

				You can start the book anywhere, but here are a few hints. Want to learn the foundations of statistics? Turn the page. Introduce yourself to Excel’s statistical features? That’s Chapter 2. Want to start with graphics? Hit Chapter 3. For anything else, find it in the Table of Contents or in the Index and go for it.

				Same final admonition as in the first edition: If you have half as much fun reading and using this book as I had writing it, you’ll have a blast. 

			

		

	
		
			
				Part I

				Statistics and Excel: A Marriage Made in Heaven
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In this part . . . 

				Part I deals with the foundations of statistics and with the statistics-related things that Excel can do. On the statistics side, this part introduces samples and populations, hypothesis testing, the two types of errors in decision-making, independent and dependent variables, and probability. It’s a brief introduction to all the statistical concepts I explore in the rest of the book. On the Excel side, I focus on cell referencing and on how to use worksheet functions, array functions, and data analysis tools. My objective is to get you thinking about statistics conceptually and about Excel as a statistical analysis tool.

			

			
		

	
		
			
				Chapter 1

				Evaluating Data in the Real World

				In This Chapter

				Introducing statistical concepts 

				Generalizing from samples to populations

				Getting into probability

				Making decisions

				New features in Excel 2007

				Understanding important Excel Fundamentals

				New features in this edition

				The field of statistics is all about decision-making — decision-making based on groups of numbers. Statisticians constantly ask questions: What do the numbers tell us? What are the trends? What predictions can we make? What conclusions can we draw?

				To answer these questions, statisticians have developed an impressive array of analytical tools. These tools help us to make sense of the mountains of data that are out there waiting for us to delve into, and to understand the numbers we generate in the course of our own work.

				The Statistical (And Related) Notions You Just Have to Know

				Because intensive calculation is often part and parcel of the statistician’s toolset, many people have the misconception that statistics is about number crunching. Number crunching is just one small part of the path to sound decisions, however.

				By shouldering the number-crunching load, software increases our speed of traveling down that path. Some software packages are specialized for statistical analysis and contain many of the tools that statisticians use. Although not marketed specifically as a statistical package, Excel provides a number of these tools, which is why I wrote this book.

				I said that number crunching is a small part of the path to sound decisions. The most important part is the concepts statisticians work with, and that’s what I talk about for most of the rest of this chapter.

				Samples and populations

				On election night, TV commentators routinely predict the outcome of elections before the polls close. Most of the time they’re right. How do they do that?

				The trick is to interview a sample of voters after they cast their ballots. Assuming the voters tell the truth about whom they voted for, and assuming the sample truly represents the population, network analysts use the sample data to generalize to the population of voters. 

				This is the job of a statistician — to use the findings from a sample to make a decision about the population from which the sample comes. But sometimes those decisions don’t turn out the way the numbers predicted. History buffs are probably familiar with the memorable picture of President Harry Truman holding up a copy of the Chicago Daily Tribune with the famous, but wrong, headline “Dewey Defeats Truman” after the 1948 election. Part of the statistician’s job is to express how much confidence he or she has in the decision.

				Another election-related example speaks to the idea of the confidence in the decision. Pre-election polls (again, assuming a representative sample of voters) tell you the percentage of sampled voters who prefer each candidate. The polling organization adds how accurate they believe the polls are. When you hear a newscaster say something like “accurate to within three percent,” you’re hearing a judgment about confidence.

				Here’s another example. Suppose you’ve been assigned to find the average reading speed of all fifth-grade children in the U.S., but you haven’t got the time or the money to test them all. What would you do? 

				Your best bet is to take a sample of fifth-graders, measure their reading speeds (in words per minute), and calculate the average of the reading speeds in the sample. You can then use the sample average as an estimate of the population average. 

				Estimating the population average is one kind of inference that statisticians make from sample data. I discuss inference in more detail in the upcoming section “Inferential Statistics.” 

				[image: Remember.eps] Now for some terminology you have to know: Characteristics of a population (like the population average) are called parameters, and characteristics of a sample (like the sample average) are called statistics. When you confine your field of view to samples, your statistics are descriptive. When you broaden your horizons and concern yourself with populations, your statistics are inferential.

				[image: Remember.eps] Now for a notation convention you have to know: Statisticians use Greek letters (μ, σ, ρ) to stand for parameters, and English letters [image: 454060-eq0102.eps], s, r) to stand for statistics. Figure 1-1 summarizes the relationship between populations and samples, and parameters and statistics.

				
					Figure 1-1: The relationship between populations, samples, parameters, and statistics.

				

				[image: 454060-fg0101.eps]

				Variables: Dependent and independent

				Simply put, a variable is something that can take on more than one value. (Something that can have only one value is called a constant.) Some variables you might be familiar with are today’s temperature, the Dow Jones Industrial Average, your age, and the value of the dollar against the euro.

				Statisticians care about two kinds of variables, independent and dependent. Each kind of variable crops up in any study or experiment, and statisticians assess the relationship between them.

				For example, imagine a new way of teaching reading that’s intended to increase the reading speed of fifth-graders. Before putting this new method into schools, it would be a good idea to test it. To do that, a researcher would randomly assign a sample of fifth-grade students to one of two groups: One group receives instruction via the new method, the other receives instruction via traditional methods. Before and after both groups receive instruction, the researcher measures the reading speeds of all the children in this study. What happens next? I get to that in the upcoming section entitled “Inferential Statistics: Testing Hypotheses.”

				For now, understand that the independent variable here is Method of Instruction. The two possible values of this variable are New and Traditional. The dependent variable is reading speed — which we might measure in words per minute.

				[image: Remember.eps] In general, the idea is to try and find out if changes in the independent variable are associated with changes in the dependent variable.

				[image: Remember.eps] In the examples that appear throughout the book, I show you how to use Excel to calculate various characteristics of groups of scores. Keep in mind that each time I show you a group of scores, I’m really talking about the values of a dependent variable.

				Types of data

				Data come in four kinds. When you work with a variable, the way you work with it depends on what kind of data it is. 

				The first variety is called nominal data. If a number is a piece of nominal data, it’s just a name. Its value doesn’t signify anything. A good example is the number on an athlete’s jersey. It’s just a way of identifying the athlete and distinguishing him or her from teammates. The number doesn’t indicate the athlete’s level of skill. 

				Next comes ordinal data. Ordinal data are all about order, and numbers begin to take on meaning over and above just being identifiers. A higher number indicates the presence of more of a particular attribute than a lower number. One example is Moh’s Scale. Used since 1822, it’s a scale whose values are 1 through 10. Mineralogists use this scale to rate the hardness of substances. Diamond, rated at 10, is the hardest. Talc, rated at 1, is the softest. A substance that has a given rating can scratch any substance that has a lower rating.

				What’s missing from Moh’s Scale (and from all ordinal data) is the idea of equal intervals and equal differences. The difference between a hardness of 10 and a hardness of 8 is not the same as the difference between a hardness of 6 and a hardness of 4.

				Interval data provides equal differences. Fahrenheit temperatures provide an example of interval data. The difference between 60 degrees and 70 degrees is the same as the difference between 80 degrees and 90 degrees.

				Here’s something that might surprise you about Fahrenheit temperatures: A temperature of 100 degrees is not twice as hot as a temperature of 50 degrees. For ratio statements (twice as much as, half as much as) to be valid, zero has to mean the complete absence of the attribute you’re measuring. A temperature of 0 degrees F doesn’t mean the absence of heat — it’s just an arbitrary point on the Fahrenheit scale.

				The last data type, ratio data, includes a meaningful zero point. For temperatures, the Kelvin scale gives us ratio data. One hundred degrees Kelvin is twice as hot as 50 degrees Kelvin. This is because the Kelvin zero point is absolute zero, where all molecular motion (the basis of heat) stops. Another example is a ruler. Eight inches is twice as long as four inches. A length of zero means a complete absence of length.

				[image: Remember.eps] Any of these types can form the basis for an independent variable or a dependent variable. The analytical tools you use depend on the type of data you’re dealing with.

				A little probability

				When statisticians make decisions, they express their confidence about those decisions in terms of probability. They can never be certain about what they decide. They can only tell you how probable their conclusions are.

				So what is probability? The best way to attack this is with a few examples. If you toss a coin, what’s the probability that it comes up heads? Intuitively, you know that if the coin is fair, you have a 50-50 chance of heads and a 50-50 chance of tails. In terms of the kinds of numbers associated with probability, that’s 1/2.

				How about rolling a die? (One member of a pair of dice.) What’s the probability that you roll a 3? Hmmm . . . a die has six faces and one of them is 3, so that ought to be 1/6, right? Right.

				Here’s one more. You have a standard deck of playing cards. You select one card at random. What’s the probability that it’s a club? Well . . . a deck of cards has four suits, so that answer is 1/4.

				I think you’’re getting the picture. If you want to know the probability that an event occurs, figure out how many ways that event can happen and divide by the total number of events that can happen. In each of the three examples, the event we were interested in (head, 3, or club) only happens one way. 

				Things can get a bit more complicated. When you toss a die, what’s the probability you roll a 3 or a 4? Now you’re talking about two ways the event you’re interested in can occur, so that’s (1 + 1)/6 = 2/6 = 1/3. What about the probability of rolling an even number? That has to be 2, 4, or 6, and the probability is (1 + 1 + 1)/6 = 3/6 = 1/2.

				On to another kind of probability question. Suppose you roll a die and toss a coin at the same time. What’s the probability you roll a 3 and the coin comes up heads? Consider all the possible events that could occur when you roll a die and toss a coin at the same time. Your outcome could be a head and 1-6, or a tail and 1-6. That’s a total of 12 possibilities. The head-and-3 combination can only happen one way. So the answer is 1/12. 

				In general the formula for the probability that a particular event occurs is

				[image: 454060-eq0101.eps]

				I began this section by saying that statisticians express their confidence about their decisions in terms of probability, which is really why I brought up this topic in the first place. This line of thinking leads us to conditional probability — the probability that an event occurs given that some other event occurs. For example, suppose I roll a die, take a look at it (so that you can’t see it), and I tell you that I’ve rolled an even number. What’s the probability that I’ve rolled a 2? Ordinarily, the probability of a 2 is 1/6, but I’ve narrowed the field. I’ve eliminated the three odd numbers (1, 3, and 5) as possibilities. In this case, only the three even numbers (2, 4, and 6) are possible, so now the probability of rolling a 2 is 1/3.

				Exactly how does conditional probability plays into statistical analysis? Read on. 

				Inferential Statistics: Testing Hypotheses

				In advance of doing a study, a statistician draws up a tentative explanation — a hypothesis — as to why the data might come out a certain way. After the study is complete and the sample data are all tabulated, he or she faces the essential decision a statistician has to make — whether or not to reject the hypothesis. 

				That decision is wrapped in a conditional probability question — what’s the probability of obtaining the data, given that this hypothesis is correct? Statistical analysis provides tools to calculate the probability. If the probability turns out to be low, the statistician rejects the hypothesis. 

				Here’s an example. Suppose you’re interested in whether or not a particular coin is fair — whether it has an equal chance of coming up heads or tails. To study this issue, you’d take the coin and toss it a number of times — say a hundred. These 100 tosses make up your sample data. Starting from the hypothesis that the coin is fair, you’d expect that the data in your sample of 100 tosses would show 50 heads and 50 tails. 

				If it turns out to be 99 heads and 1 tail, you’d undoubtedly reject the fair coin hypothesis. Why? The conditional probability of getting 99 heads and 1 tail given a fair coin is very low. Wait a second. The coin could still be fair and you just happened to get a 99-1 split, right? Absolutely. In fact, you never really know. You have to gather the sample data (the results from 100 tosses) and make a decision. Your decision might be right, or it might not.

				Juries face this all the time. They have to decide among competing hypotheses that explain the evidence in a trial. (Think of the evidence as data.) One hypothesis is that the defendant is guilty. The other is that the defendant is not guilty. Jury-members have to consider the evidence and, in effect, answer a conditional probability question: What’s the probability of the evidence given that the defendant is not guilty? The answer to this question determines the verdict. 

				Null and alternative hypotheses

				Consider once again that coin-tossing study I just mentioned. The sample data are the results from the 100 tosses. Before tossing the coin, you might start with the hypothesis that the coin is a fair one, so that you expect an equal number of heads and tails. This starting point is called the null hypothesis. The statistical notation for the null hypothesis is H0. According to this hypothesis, any heads-tails split in the data is consistent with a fair coin. Think of it as the idea that nothing in the results of the study is out of the ordinary.

				An alternative hypothesis is possible — that the coin isn’t a fair one, and it’s loaded to produce an unequal number of heads and tails. This hypothesis says that any heads-tails split is consistent with an unfair coin. The alternative hypothesis is called, believe it or not, the alternative hypothesis. The statistical notation for the alternative hypothesis is H1.

				With the hypotheses in place, toss the coin 100 times and note the number of heads and tails. If the results are something like 90 heads and 10 tails, it’s a good idea to reject H0. If the results are around 50 heads and 50 tails, don’t reject H0. 

				Similar ideas apply to the reading-speed example I gave earlier. One sample of children receives reading instruction under a new method designed to increase reading speed, the other learns via a traditional method. Measure the children’s reading speeds before and after instruction, and tabulate the improvement for each child. The null hypothesis, H0, is that one method isn’t different from the other. If the improvements are greater with the new method than with the traditional method — so much greater that it’s unlikely that the methods aren’t different from one another — reject H0. If they’re not, don’t reject H0. 

				[image: Remember.eps] Notice that I didn’t say “accept H0.” The way the logic works, you never accept a hypothesis. You either reject H0 or don’t reject H0. 

				Notice also that in the coin-tossing example I said around 50 heads and 50 tails. What does “around” mean? Also, I said if it’s 90-10, reject H0. What about 85-15? 80-20? 70-30? Exactly how much different from 50-50 does the split have to be for you reject H0? In the reading-speed example, how much greater does the improvement have to be to reject H0? 

				I won’t answer these questions now. Statisticians have formulated decision rules for situations like this, and we’ll explore those rules throughout the book.

				Two types of error

				Whenever you evaluate the data from a study and decide to reject H0 or to not reject H0, you can never be absolutely sure. You never really know what the true state of the world is. In the context of the coin-tossing example, that means you never know for certain if the coin is fair or not. All you can do is make a decision based on the sample data you gather. If you want to be certain about the coin, you’d have to have the data for the entire population of tosses — which means you’d have to keep tossing the coin until the end of time.

				Because you’re never certain about your decisions, it’s possible to make an error regardless of what you decide. As I mentioned before, the coin could be fair and you just happen to get 99 heads in 100 tosses. That’s not likely, and that’s why you reject H0. It’s also possible that the coin is biased, and yet you just happen to toss 50 heads in 100 tosses. Again, that’s not likely and you don’t reject H0 in that case.

				Although not likely, those errors are possible. They lurk in every study that involves inferential statistics. Statisticians have named them Type I and Type II.

				If you reject H0 and you shouldn’t, that’s a Type I error. In the coin example, that’s rejecting the hypothesis that the coin is fair, when in reality it is a fair coin.

				If you don’t reject H0 and you should have, that’s a Type II error. That happens if you don’t reject the hypothesis that the coin is fair, and in reality it’s biased. 

				How do you know if you’ve made either type of error? You don’t — at least not right after you make your decision to reject or not reject H0. (If it’s possible to know, you wouldn’t make the error in the first place!) All you can do is gather more data and see if the additional data are consistent with your decision.

				If you think of H0 as a tendency to maintain the status quo and not interpret anything as being out of the ordinary (no matter how it looks), a Type II error means you missed out on something big. Looked at in that way, Type II errors form the basis of many historical ironies.

				Here’s what I mean: In the 1950s, a particular TV show gave talented young entertainers a few minutes to perform on stage and a chance to compete for a prize. The audience voted to determine the winner. The producers held auditions around the country to find people for the show. Many years after the show went off the air, the producer was interviewed. The interviewer asked him if he had ever turned down anyone at an audition that he shouldn’t have. 

				“Well,” said the producer, “once a young singer auditioned for us and he seemed really odd.”

				“In what way?” asked the interviewer.

				“In a couple of ways,” said the producer. “He sang really loud, gyrated his body and his legs when he played the guitar, and he had these long sideburns. We figured this kid would never make it in show business, so we thanked him for showing up, but we sent him on his way.”

				“Wait a minute, are you telling me you turned down . . .”

				“That’s right. We actually said ‘no’ . . . to Elvis Presley!”

				Now that’s a Type II error. 

				What’s New in Excel?

				The big news in Excel 2007 — throughout Microsoft Office 2007, in fact — is the user interface. Where a bar of menus once ruled, you now find a tabbed band. Appearing near the top of the worksheet window, this band is called the Ribbon. Figure 1-2 shows the appearance of the Ribbon after I select the Insert tab.

				
					Figure 1-2: The Insert Tab in the Ribbon in Excel 2007.

				

				[image: 454060-fg0102.tif]

				The Ribbon exposes Excel’s capabilities in a way that’s much easier to understand than in previous versions. Each tab presents groups of icon-labeled command buttons rather than menu choices. Mouseover help adds still more information when you’re trying to figure out the capability a particular button activates. 

				Clicking a button typically opens up a whole category of possibilities. Buttons that do this are called category buttons. 

				Microsoft has developed shorthand for describing a mouse-click on a command button in the Ribbon, and I use that shorthand throughout this book. The shorthand is 

				Tab | Command Button

				To indicate clicking on the Insert tab’s Other Charts category button, for example, I write

				Insert | Other Charts

				By the way, when I click that button, the gallery in Figure 1-3 appears. 

				I can extend the shorthand. To select the first chart in that gallery (it’s called High-Low-Close, as mouseover help would tell you), I write

				Insert | Other Charts | High-Low-Close

				
					Figure 1-3: Clicking Insert | Other Charts opens this gallery.

				

				[image: 454060-fg0103.tif]

				The downside to all this, of course, is the Ribbon’s newness. If you’ve spent years with previous versions, you’ve developed an overall sense of where frequently used capabilities reside. Now you have to reorient: The switch from the menu bar to the Ribbon relocates almost everything.

				It’s worth your while to reorient. After you get accustomed to the Ribbon, you’ll see that everything takes just a few steps now.

				Wait a second. Figure 1-3 shows a gallery of charts to insert into a worksheet. What happened to the Chart Wizard? It’s gone from Excel 2007. In keeping with everything-takes-just-a-few-steps-now, to create a chart you

				1. Select the data to include in the chart.

				2. Insert the chart into the worksheet.

				3. Use the Design tab and the Layout tab to make modifications.

				I’ve oversimplified, but not by much, as Chapter 3 shows. Creating a chart is more intuitive than it used to be. You’re no longer confined to the order of steps specified in the Chart Wizard.

				Wait another second. Design tab? Layout tab? They’re not in Figure 1-2. After you insert a chart and select it, they appear. Tabs that appear when needed are called contextual tabs.

				Also in keeping with everything-takes-just-a-few-steps-now, to use a statistical function you

				1. Select a cell for the result of the function.

				2. Select a function from the Statistical Functions menu to open a dialog box for that function.

				3. Enter the required information into the dialog box.

				4. Close the dialog box.

				Again I’ve oversimplified, and again not by much, as you see throughout the book.

				Statistical Functions menu? Yep. This time around, you have a Statistical Functions menu that wasn’t in the earlier incarnations. It’s buried under 

				Formulas | More Functions | Statistical

				In Chapter 2 I show you how to make that menu more accessible.

				Excel 2007’s statistical functionality is by and large the same as in previous versions. The new version adds three statistical functions: COUNTIFS (counts the number of cells that meet a set of conditions), AVERAGEIF (finds the average of cells that meet a condition), AVERAGEIFS (finds the average of cells that meet a set of conditions).

				Some Things about Excel You Absolutely Have to Know

				Although I’m assuming you’re not new to Excel, I think it’s wise to take a little time and space up front to discuss a few Excel fundamentals that figure prominently in statistical work. Knowing these fundamentals helps you work efficiently with Excel formulas.

				Autofilling cells

				The first is autofill, Excel’s capability for repeating a calculation throughout a worksheet. Insert a formula into a cell, and you can drag that formula into adjoining cells. 

				Figure 1-4 is a worksheet of expenditures for R&D in science and engineering at colleges and universities for the years shown. The data, taken from a U.S. National Science Foundation report, are in millions of dollars. Column H holds the total for each field, and row 11 holds the total for each year. (More about column I in a moment.)

				
					Figure 1-4: Expenditures for R&D in science and engineering.

				

				[image: 454060-fg0104.eps]

				I started with column H blank and with row 11 blank. How did I get the totals into column H and row 11?

				If I want to create a formula to calculate the first row total (for Physical Sciences), one way (among several) is to enter

				= D2 + E2 + F2 + G2

				into cell H2. (A formula always begins with “=”.) Press Enter and the total appears in H2.

				Now, to put that formula into cells H3 through H10, the trick is to position the cursor on the lower right corner of H2 until a “+” appears, hold down the left mouse button, and drag the mouse through the cells. That “+” is called the cell’s fill handle.

				When you finish dragging, release the mouse button and the row totals appear. This saves huge amounts of time, because you don’t have to reenter the formula eight times.

				Same thing with the column totals. One way to create the formula that sums up the numbers in the first column (1990) is to enter

				=D2 + D3 + D4 + D5 + D6 + D7 + D8 + D9 + D10

				into cell D11. Position the cursor on D11’s fill handle, drag through row 11 and release in column H, and you autofill the totals into E11 through H11.

				Dragging isn’t the only way to do it. Another way is to select the array of cells you want to autofill (including the one that contains the formula), and click the down arrow next to 

				Home | Fill

				This opens the Fill pop-up menu (see Figure 1-5). Select Down and you accomplish the same thing as dragging and dropping. 

				
					Figure 1-5: The Fill pop-up menu.

				

				[image: 454060-fg0105.tif]

				Still another way is to select Series from the Fill pop-up menu. Doing this opens the Series dialog box (see Figure 1-6). In this dialog box, click the AutoFill radio button, click OK, and you’re all set. This does take one more step, but the Series dialog box is a bit more compatible with earlier versions of Excel.

				
					Figure 1-6: The Series dialog box.

				

				[image: 454060-fg0106.tif]

				I bring this up because statistical analysis often involves repeating a formula from cell to cell. The formulas are usually more complex than the ones in this section, and you might have to repeat them many times, so it pays to know how to autofill.

				Referencing cells

				The second important fundamental is the way Excel references worksheet cells. Consider again the worksheet in Figure 1-4. Each autofilled formula is slightly different from the original. This, remember, is the formula in cell H2:

				= D2 + E2 + F2 + G2

				After autofill, the formula in H3 is

				= D3 + E3 + F3 + G3

				and the formula in H4 is . . . well, you get the picture.

				This is perfectly appropriate. I want the total in each row, so Excel adjusts the formula accordingly as it automatically inserts it into each cell. This is called relative referencing — the reference (the cell label) gets adjusted relative to where it is in the worksheet. Here, the formula directs Excel to total up the numbers in the cells in the four columns immediately to the left.

				Now for another possibility. Suppose I want to know each row total’s proportion of the grand total (the number in H11). That should be straightforward, right? Create a formula for I2, and then autofill cells I3 through I10.

				Similar to the earlier example, I’d start by entering this formula into I2:

				=H2/H11

				Press Enter and the proportion appears in I2. Position the cursor on the fill handle, drag through column I, release in I10, and . . . D’oh!!! Figure 1-7 shows the unhappy result — the extremely ugly #/DIV0! in I3 through I10. What’s the story?

				
					Figure 1-7: Whoops! Incorrect autofill!

				

				[image: 454060-fg0107.eps]

				The story is this: unless you tell it not to, Excel uses relative referencing when you autofill. So the formula inserted into I3 is not 

				=H3/H11

				Instead, it’s

				=H3/H12

				Why does H11 become H12? Relative referencing assumes that the formula means divide the number in the cell by whatever number is nine cells south of here in the same column. Because H12 has nothing in it, the formula is telling Excel to divide by zero, which is a no-no. 

				The idea is to tell Excel to divide all the numbers by the number in H11, not by whatever number is nine cells south of here. To do this, you work with absolute referencing. You show absolute referencing by adding $-signs to the cell ID. The correct formula for I2 is

				= H2/$H$11

				This tells Excel not to adjust the column and not to adjust the row when you autofill. Figure 1-8 shows the worksheet with the proportions. 

				
					Figure 1-8: Autofill based on absolute referencing.

				

				[image: 454060-fg0108.eps]

				[image: Tip.eps] To convert a relative reference into absolute reference format, select the cell address (or addresses) you want to convert, and press the F4 key. F4 is a toggle that goes between relative reference (H11, for example), absolute reference for both the row and column in the address ($H$11), absolute reference for the row-part only (H$11), and absolute reference for the column-part only ($H11).

				What’s New in This Edition?

				Although Excel’s statistical functions haven’t changed, I’ve restructured the instructions for every statistical function. The instructions in this edition fit in with the steps I outlined in the preceding section.

				With the disappearance of the Chart Wizard I’ve restructured the instructions for creating a chart, too. (See Chapter 3.)

				One of my points in both editions is that when you report an average, you should also report variability. For this reason I believe Excel 2007 should also offer the functions STDEVIF and STDEVIFS in addition to the new functions AVERAGEIF and AVERAGEIFS. Unfortunately, these functions do not exist in Excel 2007. To fill the void, I show you how to do what these functions would do, and in the process take you through some of Excel’s Logical Functions. (See Chapter 5.)

				It’s easier to assign a name to a cell range in Excel 2007 (it takes . . . you guessed it . . . just-a-few-steps-now). So I rely much more on named cell ranges in this edition. (See Chapter 2.)

				In the Part of Tens, I’ve added a section on importing data from the Web. (See Chapter 20.)

				I pointed out in the Introduction that I’ve added Appendix B and Appendix C. Each one shows how to do some nifty statistical work that doesn’t come prepackaged in Excel.

			

		

	
		
			
				Chapter 2

				Understanding Excel’s Statistical Capabilities

				In This Chapter

				Working with worksheet functions

				Creating a shortcut to statistical functions

				Getting an array of results

				Naming arrays

				Tooling around with analysis

				Using Excel’s Quick Statistics feature

				In this chapter, I introduce you to Excel’s statistical functions and data analysis tools. If you’ve used Excel, and I’m assuming you have, you’re aware of Excel’s extensive functionality, of which statistical capabilities are a subset. Into each worksheet cell you can enter a piece of data, instruct Excel to carry out calculations on data that reside in a set of cells, or use one of Excel’s worksheet functions to work on data. Each worksheet function is a built-in formula that saves you the trouble of having to direct Excel to perform a sequence of calculations. As newbies and veterans know, formulas are the business end of Excel. The data analysis tools go beyond the formulas. Each tool provides a set of informative results.

				Getting Started 

				Many of Excel’s statistical features are built into its worksheet functions. In previous versions, you accessed the worksheet functions by using the Excel Insert Function button, labeled with the symbol fx. Clicking this button opens the Insert Function dialog box, which presents a list of Excel’s functions and a capability for searching for Excel functions. Although Excel 2007 provides easier ways to access the worksheet functions, this latest version preserves this button and offers additional ways to open the Insert Function dialog box. I discuss all of this in more detail in a moment.

				Figure 2-1 shows the location of the Insert Function button and the Formula Bar. They’re on the right of the Name Box. All three are just below the Ribbon. Inside the Ribbon, in the Formulas tab, is the Function Library.

				The Formula Bar is like a clone of a cell you select: Information entered into the Formula Bar goes into the selected cell, and information entered in the selected cell appears in the Formula Bar. 

				Figure 2-1 shows Excel with the Formulas tab open. This shows you another location for the Insert Function button. Labeled fx, it’s in the extreme left of the Ribbon, in the Function Library area. As I mention earlier in this section, when you click the Insert Function button, you open the Insert Function dialog box. (See Figure 2-2.)

				
					Figure 2-1: The Function Library, the Name Box, the Formula Bar, and the Insert Function button.

				

				[image: 454060-fg0201.eps]

				
					Figure 2-2: The Insert Function dialog box.

				

				[image: 454060-fg0202.tif]

				This dialog box enables you to search for a function that fits your needs, or to scroll through a list of Excel functions.

				So in addition to clicking the Insert Function button next to the Formula bar, you can open the Insert Function dialog box by selecting

				Formulas | Insert Function

				[image: Tip.eps] To open the Insert Function dialog box, you can also press Shift+F3.

				Because of the way earlier versions of Excel were organized, the Insert Function dialog box was extremely useful. In Excel 2007, however, it’s mostly helpful if you’re not sure which function to use or where to find it. 

				The Function Library presents the categories of formulas you can use and makes it convenient for you to access them. Clicking a category button in this area opens a menu of the functions in that category.

				Most of the time, I work with Statistical Functions that are easily accessible through the Statistical Functions menu. Sometimes I work with Math functions in the Math & Trig Functions menu. (You see a couple of these later in the chapter.) In Chapter 5, I work with a couple of Logic functions.

				[image: Tip.eps] The final selection of each category menu (like the Statistical Functions menu) is called Insert Function. Selecting this option is still another way to open the Insert Function dialog box.

				The Name Box is something like a running record of what you do in the worksheet. Select a cell, and the cell’s address appears in the Name Box. Click the Insert Function button and the name of the function you selected most recently appears in the Name Box.

				In addition to the statistical functions, Excel provides a number of data analysis tools you access through the Data tab’s Analysis area. 

				Setting Up for Statistics

				In this section, I show you how to use the worksheet functions and the analysis tools.

				Worksheet functions in Excel 2007

				Because the Ribbon exposes so many of Excel’s capabilities, it’s not necessary to bury them in menus any more. As I point out in the preceding section, the Function Library area of the Formulas tab shows all the categories of worksheet functions.

				The steps in using a worksheet function are:

				1. Type your data into a data array and select a cell for the result.

				2. Select the appropriate formula category and choose your function from its pop-up menu. 

				 Doing this opens the Function Arguments dialog box.

				3. In the Function Arguments dialog box, type the appropriate values for the function’s arguments.

				Argument is a term from mathematics. It has nothing to do with debates, fights, or confrontations. In mathematics, an argument is a value on which a function does its work.

				4. Click OK to put the result into the selected cell.

				Yes, that’s all there is to it.

				To give you an example, I explore a function that typifies how Excel’s worksheet functions work. This function, SUM, adds up the numbers in cells you specify and returns the sum in still another cell that you specify. Although adding numbers together is an integral part of statistical number crunching, SUM is not in the Statistical category. It is, however, a typical worksheet function and it shows a familiar operation. 

				Here, step by step, is how to use SUM.

				 1. Enter your numbers into an array of cells and select a cell for the result. 

				 In this example, I’ve entered 45, 33, 18, 37, 32, 46, 39 into cells C2 through C8, and selected C9 to hold the sum.

				2. Select the appropriate formula category and choose your function from its pop-up menu. 

				 This opens the Function Arguments dialog box.

				 I selected Formulas | Math & Trig

				 and scrolled down to find and choose SUM.

				3. In the Function Arguments dialog box, enter the appropriate values for the arguments. 

				 Excel guesses that you want to sum the numbers in cells C2 through C8 and identifies that array in the Number1 box. Excel doesn’t keep you in suspense: The Function Arguments dialog box shows the result of applying the function. In this example, the sum of the numbers in the array is 250. (See Figure 2-3.) 

				4. Click OK to put the sum into the selected cell.

				
					Figure 2-3: Using SUM.

				

				[image: 454060-fg0203.tif]

				Note a couple of points. First, as Figure 2-3 shows, the Formula Bar holds

				=SUM(C2:C8)

				This formula indicates that the value in the selected cell equals the sum of the numbers in cells C2 through C8.

				[image: Tip.eps] After you get familiar with a worksheet function and its arguments, you can bypass the menu and type the function directly into the cell or into the formula bar, beginning with “=”. When you do, Excel opens a helpful menu as you type the formula. (See Figure 2-4.) The menu shows possible formulas beginning with the letter(s) you type, and you can select one by double-clicking it.

				
					Figure 2-4: As you type a formula, Excel opens a helpful menu.

				

				[image: 454060-fg0204.tif]

				Another noteworthy point is the set of boxes in the Function Arguments dialog box in Figure 2-3. In the figure you see just two boxes, Number1 and Number2. The data array appears in Number1. So what’s Number2 for?

				The Number2 box allows you to include an additional argument in the sum. And it doesn’t end there. Click in the Number2 box and the Number3 box appears. Click in the Number3 box, and the Number4 box appears . . . and on and on. The limit is 255 boxes, with each box corresponding to an argument. A value can be another array of cells anywhere in the worksheet, a number, an arithmetic expression that evaluates to a number, a cell ID, or a name that you have attached to a range of cells. (Regarding that last one: Read the upcoming section “What’s in a name? An array of possibilities.”) As you type in values, the SUM dialog box shows the updated sum. Clicking OK puts the updated sum into the selected cell.

				[image: Remember.eps] You won’t find this multiargument capability on every worksheet function. Some are designed to work with just one argument. For the ones that do work with multiple arguments, however, you can incorporate data that resides all over the worksheet. Figure 2-5 shows a worksheet with a Function Arguments dialog box that includes data from two arrays of cells, two arithmetic expressions, and one cell. Notice the format of the function in the Formula Bar (acomma separates successive arguments).

				
					Figure 2-5: Using SUM with five arguments.

				

				[image: 454060-fg0205.tif]

				[image: Tip.eps] If you select a cell in the same column as your data and just below the last data cell, Excel correctly guesses the data array that you want to work on. Excel doesn’t always guess what you want to do, however. Sometimes when Excel does guess, its guess is incorrect. When either of those things happens, it’s up to you to enter the appropriate values into the Function Arguments dialog box.

				Quickly accessing statistical functions

				In the preceding example, I show you a function that’s not in the category of statistical functions. In this section, I show you how to create a shortcut to Excel’s statistical functions.

				You can get to Excel’s statistical functions by selecting 

				Formulas | More Functions | Statistical 

				and then choosing from the resulting pop-up menu. (See Figure 2-6.)

				
					Figure 2-6: Accessing Excel’s Statistical Functions.

				

				[image: 454060-fg0206.tif]

				Although Excel has buried the statistical functions several layers deep, you can use a handy Excel 2007 technique to make them as accessible as any of the other categories: You add them to the Quick Access Toolbar in the upper-left corner. (Every Office 2007 application has one.)

				To do this, select 

				Formulas | More Functions 

				and right-click on Statistical. On the pop-up menu, pick the first option; Add to Quick Access Toolbar. (See Figure 2-7.) Doing this adds a button to the Quick Access Toolbar. Clicking the new button’s down arrow opens the pop-up menu of statistical functions. (See Figure 2-8.) 

				
					Figure 2-7: Adding the Statistical functions to the Quick Access Toolbar.

				

				[image: 454060-fg0207.tif]

				
					Figure 2-8: The Statistical Functions menu.

				

				[image: 454060-fg0208.tif]

				From now on, when I deal with a statistical function, I assume that you’ve created this shortcut, so you can quickly open the menu of statistical functions. The next section provides an example.

				Array functions

				Most of Excel’s built-in functions are formulas that calculate a single value (like a sum) and put that value into a worksheet cell. Excel has another type of function. It’s called an array function because it calculates multiple values and puts those values into an array of cells, rather than into a single cell.

				FREQUENCY is a good example of an array function (and it’s an Excel statistical function, too). Its job is to summarize a group of scores by showing how the scores fall into a set of intervals that you specify. For example, given these scores

				77, 45, 44, 61, 52, 53, 68, 55

				and these intervals

				50, 60, 70, 80

				FREQUENCY shows how many are less than or equal to 50 (2 in this example), how many are greater than 50 and less than or equal to 60 (that would be 3), and so on. The number of scores in each interval is called a frequency. A table of the intervals and the frequencies is called a frequency distribution. 

				Here’s an example of how to use FREQUENCY:

				1. Enter the scores into an array of cells.

				 Figure 2-9 shows a group of scores in cells B2 through B16. 

				2. Enter the intervals into an array.

				 I’ve put the intervals in C2 through C9. 

				3. Select an array for the frequencies. 

				 I’ve put Frequency as the label at the top of column D, so I select D2 through D10 for the resulting frequencies. Why the extra cell? FREQUENCY returns a vertical array that has one more cell than the frequencies array.

				 4. From the Statistical Functions menu, select FREQUENCY to open the Function Arguments dialog box.

				 I used the shortcut I installed on the Quick Access Toolbar to open this menu and select FREQUENCY.

				
					Figure 2-9: Working with FREQUENCY.

				

				[image: 454060-fg0209.tif]

				5. In the Function Arguments dialog box, enter the appropriate values for the arguments.

				 I begin with the Data_array box. In this box I entered the cells that hold the scores. In this example, that’s B2:B16. I’m assuming you know Excel well enough to know how to do this in several ways. 

				 Next, I identify the intervals array. FREQUENCY refers to intervals as “bins,” and holds the intervals in the Bins_array box. For this example, C2:C9 goes into the Bins_array box. After identifying both arrays, the Insert Function dialog box shows the frequencies inside a pair of curly brackets.

				6. Press Ctrl+Shift+Enter to Close the Function Arguments dialog box and put the values in the selected array.

				 This is VERY important. Because the dialog box has an OK button, the tendency is to click OK, thinking that puts the results into the worksheet. That doesn’t get the job done when you work with an array function, however. Always use the keystroke combination Ctrl+Shift+Enter to close the Function Arguments dialog box for an array function.

				After closing the Function Arguments dialog box, the frequencies go into the appropriate cells, as Figure 2-10 shows.

				
					Figure 2-10: The finished frequencies.

				

				[image: 454060-fg0210.tif]

				Note the formula in the Formula Bar:

				{= FREQUENCY(B2:B16,C2:C9)}

				The curly brackets are Excel’s way of telling you that this is an array function.

				[image: Remember.eps] I’m not one to repeat myself, but in this case I’ll make an exception. As I said in Step 6, press Ctrl+Shift+Enter whenever you work with an array function. Keep this in mind because the Arguments Function dialog box doesn’t provide any reminders. If you click OK after you enter your arguments into an array function, you’ll be very frustrated. Trust me.

				What’s in a name? An array of possibilities

				As you get more into Excel’s statistical features, you work increasingly with formulas that have multiple arguments. Oftentimes, these arguments refer to arrays of cells, as in the preceding examples. 

				If you apply meaningful names to these arrays, it helps you keep straight what you’re doing. Also, if you come back to a worksheet after being away from it for a while, meaningful array names can help you quickly get back into the swing of things. Another benefit: If you have to explain your worksheet and its formulas to others, meaningful array names are tremendously helpful.

				Excel gives you an easy way to attach a name to a group of cells. In Figure 2-11, column C is named Revenue_Millions, indicating “Revenue in millions of dollars.” As it stands, that just makes it a bit easier to read the column. If I explicitly tell Excel to treat Revenue_Millions as the name of the array of cells C2 through C13, however, I can use Revenue_Millions whenever I refer to that array of cells.

				
					Figure 2-11: Defining names for arrays of cells.

				

				[image: 454060-fg0211.tif]

				Why did I use Revenue_Millions and not Revenue (Millions) or Revenue In Millions or Revenue: Millions? Excel doesn’t like blank spaces or symbols inits names. In fact, here are four rules to follow when you supply a name fora range of cells:

				Begin a name with an alphabetic character — a letter rather than a number or a punctuation mark.

				As I just mentioned, make sure that the name contains no spaces or symbols. Use an underscore to denote a space between words in the name. 

				Be sure that the name is unique within the worksheet.

				Be sure that the name doesn’t duplicate any cell reference in the worksheet.

				Here’s how to define a name:

				1. Put a descriptive name at the top of a column (or to the left of a row) you want to name.

				 Figure 2-10 shows this.

				2. Select the range of cells you want to name. 

				 For this example, that’s cells C2 through C13. Why not include C1? I explain in a second.

				3. Right-click on the selected range.

				 This opens the menu shown in Figure 2-12. 

				
					Figure 2-12: Right-clicking a selected cell range opens this pop-up menu.
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				4. From the pop-up menu, select Name a Range.

				 This selection opens the New Name dialog box (see Figure 2-13). As you can see, Excel knows that Revenue_Millions is the name for the array, and that Revenue_Millions refers to cells C2 through C13. When presented with a selected range of cells to name, Excel looks for a nearby name — just above a column or just to the left of a row. If no name is present, you get to supply one in the New Name dialog box. (The New Name dialog box is also accessible by choosing Formula | Define Name.)

				
					Figure 2-13: The New Name dialog box.

				

				[image: 454060-fg0213.eps]

				[image: Warning(bomb).eps] When you select a range of cells like a column with a name at the top, you can include the cell with the name in it and Excel attaches the name to the range. I strongly advise against doing this. Why? If I select C1 through C13, the name Revenue_Millions refers to cells C1 through C13, not C2 through C13. In that case, the first value in the range is text and the others are numbers. 

				 For a formula like SUM (or SUMIF or SUMIFS, which I discuss next), this doesn’t make a difference: In those formulas, Excel just ignores values that aren’t numbers. If you have to use the whole array in a calculation, however, it makes a huge difference: Excel thinks the name is part of the array and tries to use it in the calculation. You’ll see this in the next section on creating your own array formulas.

				5. Click OK.

				 Excel attaches the name to the range of cells.

				Now I have the convenience of using the name in a formula. Here, selecting a cell (like C14) and entering the SUM formula directly into C14 opens the boxes in Figure 2-14. 

				
					Figure 2-14: Entering a formula directly into a cell opens these boxes.
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				As the figure shows, the boxes open as I type. Pressing the Tab key fills in the formula in a way that Excel understands. I have to supply the close parenthesis (see Figure 2-15) and type Enter to see the result.

				Using the named array, then, the formula is 

				=SUM(Revenue_Millions)

				which is more descriptive than

				=SUM(C2:C13)

				A couple of Excel 2007’s new formulas show just how convenient this naming capability is. These formulas, SUMIF and SUMIFS, add a set of numbers if specific conditions in one cell range (SUMIF) or in more than one cell range (SUMIFS) are met. SUMIFS is new in Excel 2007.

				To take full advantage of naming, I name both column A (Year) and column B (Region) in the same way I named column C. 

				
					Figure 2-15: Completing the formula.
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				[image: Warning(bomb).eps] When you define a name for a cell range like B2:B13 in this example, beware: Excel can be a bit quirky when the cells hold names. Excel might guess that the name in the uppermost cell is the name you want to assign to the cell range. In this case, Excel guesses “North” for the name, rather than “Region.” Ifthat happens, you make the change in the New Name dialog box.

				To keep track of the names in a worksheet, selecting 

				Formula | Name Manager 

				opens the Name Manager box shown in Figure 2-16. The nearby buttons in the Defined Names area are also useful.

				
					Figure 2-16: Managing the Defined Names in a worksheet.
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				Next, I sum the data in column C, but only for the North Region. That is, I only consider a cell in column C if the corresponding cell in column B contains “North.” To do this, I followed these steps:

				1. Select a cell for the formula result.

				 My selection here is C15.

				2. Select the appropriate formula category and choose your function from its pop-up menu. 

				 This opens the Function Arguments dialog box.

				 I selected Formulas | Math & Trig

				 and scrolled down the menu to find and choose SUMIF. This selection opens the Function Arguments dialog box shown in Figure 2-17. 

				
					Figure 2-17: The Function Arguments dialog box for SUMIF.
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				 SUMIF has three arguments. The first, Range, is the range of cells to evaluate for the condition to include in the sum (North, South, East, or West in this example). The second, Criteria, is the specific value in the Range (North, for this example). The third, Sum_range, holds the values I sum.

				3. In the Function Arguments dialog box, enter the appropriate values for the arguments.

				 Here’s where another Defined Names button comes in handy. In that Ribbon area, click the down arrow next to Use in Formula to open the drop-down list shown in Figure 2-18. 

				
					Figure 2-18: The Use In Formula drop-down list.
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				 Selecting from this list fills in the Function Arguments dialog box, as shown in Figure 2-19. I had to type North into the Criteria box. Excel adds the double quotes.

				4. Click OK.

				 The result appears in the selected cell. For this example, that’s 78.

				
					Figure 2-19: Completing the Function Arguments dialog box for SUMIF.
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				In the formula bar, 

				=SUMIF(Region,”North”, Revenue_Millions) 

				appears. I can type it exactly that way into the formula bar, without the dialog box or the drop-down list. 

				The formula in the formula bar is easier to understand than

				= SUMIF(B2:B13,”North”, C2:C13)

				isn’t it?

				Incidentally, the same cell range can be both the Range and the Sum_range. For example, to sum just the cells for which Revenue_Millions is less than 25, that’s

				=SUMIF(Revenue_Millions, “< 25”, Revenue_Millions)

				The second argument (Criteria) is always in double-quotes.

				What about SUMIFS? That one is useful if I want to find the sum of revenues for North but only for the years 2006 and 2007. Follow these steps to use SUMIFS to find this sum:

				1. Select a cell for the formula result.

				 The selected cell is C17.

				2. Select the appropriate formula category and choose your function from its pop-up menu. 

				 This opens the Function Arguments dialog box.

				 For this example, the selection is SUMIFS from the 

				Formulas | Math & Trig

				 menu, opening the Functions Arguments dialog box shown in Figure 2-20.

				3. In the Function Arguments dialog box, enter the appropriate values for the arguments.

				 Notice that in SUMIFS the Sum_range argument appears first. In SUMIF, itappears last. The appropriate values for the arguments appear in Figure 2-20.

				4. The formula in the Formula bar is

				=SUMIFS(Revenue_Millions,Year,”<2008”,Region,”North”)

				 5. Click OK.

				 The answer, 46, appears in the selected cell.

				With unnamed arrays, the formula would have been

				=SUMIFS(C2:C13,A2:A13,”<2008”,B2:B13,”North”)

				which seems much harder to comprehend.

				
					Figure 2-20: The Completed Function Arguments dialog box for SUMIFS.
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				[image: Warning(bomb).eps] A defined name involves absolute referencing. (See Chapter 1.) Therefore, if you try to autofill from a named array, you’ll be in for an unpleasant surprise: Rather than autofilling a group of cells, you’ll be copying a value over and over again.

				Here’s what I mean. Suppose you assign the name Series_1 to A2:A11 and Series_2 to B2:B11. In A12, you calculate SUM(Series_1). Being clever, you figure you’ll just drag the result from A12 to B12 to calculate SUM(Series_2). What do you find in B12? SUM(Series_1), that’s what.

				Creating your own array formulas 

				In addition to Excel’s built-in array formulas, you can create your own. To help things along, you can incorporate named arrays.

				Figure 2-21 shows two named arrays, X and Y in columns C and D. X refers to C2 through C5 (not C1 through C5!) and Y refers to D2 through D5 (not D1 through D5!) XY is the column header for column F. Each cell in column F will store the product of the corresponding cell in column C and the corresponding cell in column D.

				
					Figure 2-21: Two named arrays.
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				An easy way to enter the products, of course, is to just set F2 equal to C2*E2 and then autofill the remaining applicable cells in column F.

				Just to illustrate array formulas, though, I follow these steps to work on the data in the worksheet in Figure 2-21.

				1. Select the array that will hold the answers to the array formula.

				 That would be F2 through F5, or F2:F5 in Excel-speak. Figure 2-21 shows the array selected.

				2. Into the selected array, type the formula.

				 The formula here is =X * Y

				3. Press Ctrl+Shift+Enter (not Enter).

				 The answers appear in F2 through F5, as Figure 2-22 shows. Note the formula {=X*Y} 

				 in the formula bar. As I told you earlier, the curly brackets indicate an array formula.

				
					Figure 2-22: The results of the array formula {=X * Y}.

				

				[image: 454060-fg0222.tif]

				Another thing I mention earlier in this chapter: When you name a range of cells, make sure that the named range does not include the cell with the name in it. If it does, an array formula like {=X * Y} tries to multiply the letter X by the letter Y to produce the first value, which is impossible and results in the exceptionally ugly #VALUE! error. 

				Using data analysis tools

				Excel has a set of sophisticated tools for data analysis. Table 2-1 lists the tools I cover. (The one I don’t cover, Fourier Analysis, is extremely technical.) Some of the terms in the table may be unfamiliar to you, but you’ll know them by the time you finish this book.

				
					
						
								
								Table 2-1 Excel’s Data Analysis Tools

							
						

						
								
								Tool

							
								
								What It Does

							
						

						
								
								Anova: Single Factor

							
								
								Analysis of variance for two or more samples

							
						

						
								
								Anova: Two Factor with Replication

							
								
								Analysis of variance with two independent variables, and multiple observations in each combination of the levels of the variables

							
						

						
								
								Anova: Two Factor without Replication

							
								
								Analysis of variance with two independent variables, and one observation in each combination of the levels of the variables

							
						

						
						
								
								Correlation

							
								
								With more than two measurements on a sample of individuals, calculates a matrix of correlation coefficients for all possible pairs of the measurements 

							
						

						
								
								Covariance

							
								
								With more than two measurements on a sample of individuals, calculates a matrix of covariances for all possible pairs of the measurements 

							
						

						
								
								Descriptive Statistics

							
								
								Generates a report of central tendency, variability, and other characteristics of values in the selected range of cells

							
						

						
								
								Exponential Smoothing 

							
								
								In a sequence of values, calculates a prediction based on a preceding set of values, and on a prior prediction for those values

							
						

						
								
								F-Test Two Sample for Variances

							
								
								Performs an F-test to compare two variances

							
						

						
								
								Histogram

							
								
								Tabulates individual and cumulative frequencies for values in the selected range of cells

							
						

						
								
								Moving Average

							
								
								In a sequence of values, calculates a prediction which is the average of a specified number of preceding values

							
						

						
								
								Random Number Generation

							
								
								Provides a specified amount of random numbers generated from one of seven possible distributions

							
						

						
								
								Rank and Percentile

							
								
								Creates a table that shows the ordinal rank and the percentage rank of each value in a set of values

							
						

						
								
								Regression 

							
								
								Creates a report of the regression statistics based on linear regression through a set of data containing one dependent variable and one or more independent variables

							
						

						
								
								Sampling

							
								
								Creates a sample from the values in a specified range of cells

							
						

						
								
								t-Test: Two Sample

							
								
								Three t-test tools test the difference between two means. One assumes equal variances in the two samples. Another assumes unequal variances in the two samples. The third assumes matched samples.

							
						

						
								
								z-Test: Two Sample for Means

							
								
								Performs a two-sample z-test to compare two means when the variances are known

							
						

					
				

				In order to use these tools, you first have to load them into Excel. 

				To start, click the Office Button and select Excel Options. Doing this opens the Excel Options dialog box. Then follow these steps:

				1. In the Excel Options dialog box, select Add-Ins. 

				 Oddly enough, this opens a list of add-ins. 

				2. Near the bottom of the list, you see a drop-down list labeled Manage. From this list, select Excel Add-Ins. 

				3. Click Go. 

				 This opens the Add-Ins dialog box. (See Figure 2-23.) 

				4. Click the check box next to Analysis Toolpak and then click OK.

				
					Figure 2-23: The Add-Ins dialog box.

				

				[image: 454060-fg0223.tif]

				When Excel finishes loading the Toolpak, you’ll find a Data Analysis button in the Analysis area of the Data tab. In general, the steps for using a data analysis tool are:

				1. Enter your data into an array.

				2. Click Data | Data Analysis to open the Data Analysis dialog box.

				3. In the Data Analysis dialog box select the data analysis tool you want to work with.

				4. Click OK (or just double-click the selection) to open the dialog box for the selected tool.

				5. In the tool’s dialog box, enter the appropriate information. 

				 I know this sounds like a cop-out, but each tool is different.

				6. Click OK to close the dialog box and see the results.

				Here’s an example to get you accustomed to using these tools. In this example, I go through the Descriptive Statistics tool. This tool calculates a number of statistics that summarize a set of scores.

				1. Enter your data into an array.

				 Figure 2-24 shows an array of numbers in cells B2 through B9, with a column header in B1.

				2. Click Data | Data Analysis to open the Data Analysis dialog box.

				3. Click Descriptive Statistics and click OK (or just double-click Descriptive Statistics) to open the Descriptive Statistics dialog box. 

				4. Identify the data array.

				 In the Input Range box, enter the cells that hold the data. For this example, that’s B1 through B9. The easiest way to do this is to move the cursor to the top cell (B1), press the Shift key, and click the bottom cell (B9). That puts the absolute reference format $B$1:$B$9 into Input Range.

				5. Click the Columns radio button to indicate that the data are organized by columns.

				6. Check the Labels in First Row checkbox, because the Input Range includes the column heading.

				7. Click the New Worksheet Ply radio button, if it isn’t already selected.

				 This tells Excel to create a new tabbed sheet within the current worksheet, and to send the results to the newly created sheet.

				
					Figure 2-24: Working with the Descriptive Statistics Analysis tool.
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				8. Click the Summary Statistics checkbox and leave the others unchecked. Click OK.

				 The new tabbed sheet (ply) opens, displaying statistics that summarize the data. Figure 2-25 shows the new ply, after I widened Column A.

				
					Figure 2-25: The output of the Descriptive Statistics Analysis tool.
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				For now, I won’t tell you the meaning of each individual statistic in the Summary Statistics display. I leave that for Chapter 7 when I delve more deeply into descriptive statistics. 

				Accessing Commonly Used Functions

				Need quick access to a few commonly used Statistical functions? You can get to AVERAGE, MIN (minimum value in a selected cell range), and MAX (maximum value in a selected range) by clicking the down arrow next to a button on the Home tab. Clicking this down arrow also gets you to the Mathematical functions SUM and COUNT NUMBERS (counts the numerical values in a cell range).

				For some reason, this button is in the Editing area. It’s labeled Σ. Figure 2-26 shows you exactly where it is and the menu its down arrow opens. 

				By the way, if you just click the button

				Home | Σ

				and not the down arrow, you get SUM.

				The last selection on that menu is yet another way to open the Insert Function dialog box.

				
					Figure 2-26: The Home | Σ button and the menu its down arrow opens.
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				[image: Tip.eps] One nice thing about using this menu — it eliminates a step: When you select a function, you don’t have to select a cell for the result. Just select the cell range and the function inserts the value in a cell immediately after the range.

			

		

	
		
			
				Part II

				Describing Data

				
				[image: 454060-pp0201.eps]
			
In this part . . . 

				Here’s where you learn how to use statistics to summarize and describe data. I begin by showing you how to use the Excel graphics capabilities to produce the kinds of graphs statisticians use. From there, I move on todescriptive statistics — average, variance, standard deviation, and some others. I tell you how to combine a couple of these statistics to standardize scores. Finally, Idescribe the normal distribution, a very important topic in statistics. Along the way, you find out about Excel functions and data analysis tools that cover all the statistical ideas in this part.

			

			
		

	
		
			
				Chapter 3

				Show and Tell: Graphing Data

				In This Chapter

				Introducing graphs

				Working with Excel’s graphics capabilities

				Creating graphs for statistical work

				The visual presentation of data is extremely important in statistics. Visual presentation enables you to discern relationships and trends you might not see if you just look at numbers. Visual presentation helps in another way: It’s valuable for presenting ideas to groups and making them understand your point of view. 

				Graphs come in many varieties. In this chapter, I explore the types of graphs you use in statistics and when it’s advisable to use them. I also show you how to use Excel to create those graphs.

				Why Use Graphs?

				Suppose you have to make a pitch to a Congressional committee about commercial space revenues in the early 1990s.

				Which would you rather present? The data in Table 3-1, or the graph in Figure 3-1 that shows the same data? (The data, by the way, are from the U.S. Department of Commerce, via the Statistical Abstract of the U.S.) 

				
					
						
								
								Table 3-1 US Commercial Space Revenues from 1990 through 1994 (In Millions of Dollars)

							
						

						
								
								Industry

							
								
								1990

							
								
								1991

							
								
								1992

							
								
								1993

							
								
								1994

							
						

						
								
								Commercial Satellites Delivered

							
								
								1,000

							
								
								1,300

							
								
								1,300

							
								
								1,100

							
								
								1,400

							
						

						
								
								Satellite Services

							
								
								800

							
								
								1,200

							
								
								1,500

							
								
								1,850

							
								
								2,330

							
						

						
								
								Satellite Ground Equipment

							
								
								860

							
								
								1,300

							
								
								1,400

							
								
								1,600

							
								
								1,970

							
						

						
								
								Commercial Launches

							
								
								570

							
								
								380

							
								
								450

							
								
								465

							
								
								580

							
						

						
								
								Remote Sensing Data 

							
								
								155

							
								
								190

							
								
								210

							
								
								250

							
								
								300

							
						

						
								
								Commercial R&D Infrastructure

							
								
								0

							
								
								0

							
								
								0

							
								
								30

							
								
								 60

							
						

						
								
								Total

							
								
								3,385

							
								
								4,370

							
								
								4,860

							
								
								5,295

							
								
								6,640

							
						

					
				

				
				Which one would have a greater and more lasting impact? Although the table is certainly informative, most would argue that the graph gets the point across better and more memorably. Eyes that glaze over when looking at numbers often shine brighter when looking at pictures. 

				
					Figure 3-1: Graphing the data in Table 3-1.
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The graph shows you trends you might not see as quickly on the table. (Satellite services rose fastest. Commercial launches, not so much.) Bottom line: Tables are good, graphs are better.

				Graphs help bring concepts to life that might otherwise be difficult to understand. In fact, I do that throughout the book. I illustrate points by . . . well . . . illustrating points! 

				Some Fundamentals

				Like the graph in Figure 3-1, most graph formats have a horizontal axis and a vertical axis. The pie graph, a format I show you later in this chapter, does not. By convention, the horizontal axis is also called the x-axis and the vertical axis is also called the y-axis. 

				Also, by convention, what goes on the horizontal axis is called the independent variable and what goes on the vertical axis is called the dependent variable. One of Excel’s graph formats reverses that convention, and I bring that to your attention when I cover it. 

				[image: Tip.eps] Just to give you a heads up, Excel calls that reversed-axis format a bar graph. You might have seen the graph in Figure 3-1 referred to as a bar graph. So have I. Excel calls Figure 3-1 a column graph, so I use “columns” from here on.

				Getting back to “independent” and “dependent,” those terms imply that changes in the vertical direction depend (at least partly) on changes in the horizontal direction.

				Another fundamental principle of creating a graph: Don’t wear out the viewer’s eyes! If you put too much into a graph in the way of information or special effects, you defeat the whole purpose of the graph. 

				For example, in Figure 3-1 I had to make some choices about filling in the columns. Color-coded columns would have been helpful, but the page you’re looking at only shows black, white, and shades of gray. 

				A lot of graph creation comes with experience, and you just have to use your judgment. In this case, my judgment came into play with the horizontal gridlines. In most graphs, I prefer not to have them. Here, they seem to add structure and help the viewer figure out the dollar value associated with each column. But then again, that’s just my opinion.

				Excel’s Graphics Capabilities

				As I mention a couple of paragraphs ago, the graph in Figure 3-1 is a column graph. It’s one of many types of graphs you can create with Excel. Of all the graphics possibilities Excel provides, however, only a few are useful for statistical work. Those are the ones I cover in this chapter.

				In addition to the column graph, I show you how to create pie graphs, bar graphs, line graphs, and scatter plots. Excel refers to each one as a chart rather than a “graph.” In this chapter, I use the two terms interchangeably.

				Inserting a chart

				In Excel 2007, you insert a chart into a spreadsheet. This immediately clues you that the chart creation tools are in the Charts area of the Insert tab. (See Figure 3-2.)

				
					Figure 3-2: The Charts area of the Insert tab.
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				In Excels past a Chart Wizard guided you step by step through chart creation. The chart took shape within the wizard as you worked. You didn’t see the full chart on the worksheet (or on a separate page) until you closed the wizard. 

				Excel 2007 turns the process inside out and simplifies it. Instead of making decisions within the wizard (which is no longer available), you immediately insert a chart into your spreadsheet. Then you use Design and Layout capabilities to modify the chart and make it look just the way you want it.

				You follow these steps:

				1. Enter your data into a worksheet.

				2. Select the data that go into the chart.

				3. In the Charts area of the Insert tab, select the chart type.

				 When you select a chart type, a box opens that presents a variety of subtypes. Choose one and Excel creates a chart in your worksheet.

				4. Modify the chart.

				 Click on the chart, and Excel adds a Design tab and a Layout tab to the Ribbon. These tabs allow you to make all kinds of changes to your chart.

				It’s really that simple. The next section shows what I mean.

				[image: Tip.eps] By the way, here’s one more important concept about Excel graphics. In Excel, a chart is dynamic. This means that after you create a chart, changing its worksheet data results in an immediate change in the chart.

				Becoming a Columnist

				In this section, I show you how to create that spiffy graph in Figure 3-1. Follow these steps:

				1. Enter your data into a worksheet. 

				 Figure 3-3 shows the data from Table 3-1 entered into a worksheet. 

				
					Figure 3-3: Table 3-1 data entered into a worksheet.

				

				[image: 454060-fg0303.tif]

				2. Select the data that go into the chart.

				 I selected A1:F7. The selection includes the labels for the axes but doesn’t include row G, which holds the column totals.

				 3. In the Charts area of the Insert tab, select the chart type.

				 For this example, the chart type is Column. Selecting Insert | Charts | Column opens the gallery in Figure 3-4. Here, you select the specific type of column chart for the data. I selected the first choice in the top row (Clustered Column).

				
					Figure 3-4: The gallery for a column chart.

				

				[image: 454060-fg0304.tif]

				4. Modify the chart.

				 Figure 3-5 shows the resulting chart, as well as the Design tab and the Layout tab. As you can see, I have to do some heavyweight modifying. Why? Excel has guessed wrong about how I wanted to design the chart. It looks okay, but it’s not. Rather than the years on the x-axis, Excel laid out the industry types. In other words, it interchanged the rows and columns.

				
					Figure 3-5: The semi-finished graph — based on a bad guess By Excel.

				

				[image: 454060-fg0305.tif]

				 Fortunately, Excel provides a quick fix. Figure 3-5 shows the Design tab selected. In the Design | Data area, the choice on the left is Switch Row/Column. So . . . selecting Design | Data | Switch Row/Column does the trick.

				 Some work remains. The axes aren’t labeled yet, and the graph has no title. Here’s where the Layout tab comes into play. Figure 3-6 shows Layout | Axis Titles selected, along with the drop-down menu that allows you to add the title for each axis. Primary Horizontal Axis Title and Primary Vertical Axis Title provide options for laying out the axis titles. Layout | Chart Title does the same for the title of the chart. 

				 Adding the titles finishes things off. The result looks like the chart in Figure 3-1.

				
					Figure 3-6: The Layout tab enables you to add titles.

				

				[image: 454060-fg0306.tif]

				Stacking the columns

				If I had selected Column’s second subtype — Stacked Column — I would have created a set of columns that presents the same information in a slightly different way. Each column represents the total of all the data series at a point on the x-axis. Each column is divided into segments. Each segment’s size is proportional to how much it contributes to the total. Figure 3-7 shows this. 

				
					Figure 3-7: A stacked column graph of the data in Table 3-1.

				

				[image: 454060-fg0307.tif]

				Notice that the data series are in reverse order from the way they’re set up in the first column graph. Excel sets them up in this order for the stacked columns, and in the other order for the clustered columns. 

				I inserted each graph into the worksheet. Excel also allows you to move a graph to a separate page in the workbook. Select Design | Location | Move Chart (it’s on the extreme right of the Design tab) to open the Move Chart dialog box. Click the New Sheet radio button to add a worksheet and move the chart there. Figure 3-8 shows how the chart looks on its own page.

				In Appendix C, by the way, I show you another use for the stacked column chart.

				This is a nice way of showing percentage changes over the course of time. If you just want to focus on percentages in one year, another type of graph is more effective. I discuss it in a moment, but first I want to tell you . . . 

				
					Figure 3-8: The stacked column chart on its own worksheet.
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				One more thing 

				Statisticians often use column graphs to show how frequently something occurs. For example, in a thousand tosses of a pair of dice how many times does a 6 come up? How many tosses result in a 7? The x-axis shows each possible outcome of the dice-tosses, and the heights of the columns represent the frequencies. Whenever the heights represent frequencies, your column graph is a histogram.

				It’s easy enough to use Excel’s graphics capabilities to set up a histogram, but Excel makes it easier still. Excel provides a data analysis tool that does everything you need to create a histogram. It’s called — believe it or not — Histogram. You provide an array of cells that hold all the data — like the outcomes of many dice-tosses, and an array that holds a list of intervals — like the possible outcomes of the tosses (the numbers 2–12). Histogram goes through the data array, counts the frequencies within each interval, and then draws the column graph. I describe this tool in greater detail in Chapter 7.

				Slicing the Pie

				On to the next chart type. To show the percentages that make up one total, a pie graph gets the job done effectively. 

				Suppose you want to focus on the U.S. commercial space revenues in 1994 — that is, on the last column of data in Table 3-1. You’ll catch people’s attention if you present the data in the form of a pie graph, like the one in Figure 3-9.

				
					Figure 3-9: A pie graph of the last column of data in Table 3-1.

				

				[image: 454060-fg0309.tif]

				Here’s how to create this graph:

				1. Enter your data into a worksheet.

				 Pretty easy, as I’ve already done this.

				2. Select the data that go into the chart.

				 I want the names in column A and the data in column F. The trick is to select column A (cells A2 through A7) in the usual way and then press and hold the CTRL key. While holding this key, drag the cursor through F2 through F7. Voilà — two nonadjoining columns are selected 

				3. In the Charts area of the Insert tab, select the chart type.

				 I selected Insert | Pie and then chose the first subtype.

				4. Modify the chart.

				 Figure 3-10 shows the initial pie chart on its own page. To get it to look like Figure 3-9, I had to do a lot of modifying. 

				
					Figure 3-10: The initial pie chart on its own page.

				

				[image: 454060-fg0310.tif]

				 The little slice filled in black represents 1 percent of the pie (Commercial R&D Infrastructure) and might be hard to see. I changed the fill color from black to white and added a border. How? I clicked on that slice and several slices were selected. Clicking again isolated it. Then I right-clicked to open the menu in Figure 3-11. Choosing Format Data Point opens the Format Data Point dialog box (Figure 3-12). I worked with Fill and Border to change the slice to a white fill with a black border.

				
					Figure 3-11: Right-clicking an isolated pie chart slice opens this menu.

				

				[image: 454060-fg0311.tif]

				
					Figure 3-12: The Format Data Point dialog box.

				

				[image: 454060-fg0312.tif]

				 I selected Layout | Data Labels | Best Fit to add the data to each slice. 

				 With the data labels selected, I right-clicked to open a couple of menus (Figure 3-13) that enabled me to manipulate the color and size of the data label font. After I made them all white, the label outside the small slice became invisible, but right-clicking in its area allowed me to reset its font to black. Right-clicking on the legend brings up the same menus for modifying the size of the font in the legend.

				
					Figure 3-13: Menus for manipulating the color and size of the data label font.

				

				[image: 454060-fg0313.tif]

				Pulling the slices apart

				One variant of the pie chart is to explode the slices. I’m not particularly fond of this type of graph, but you might be. In some circumstances, it might come in handy. 

				One of the nice things about Excel’s graphics capabilities is that you can “what-if” to your heart’s content. So . . . after I finish creating the pie chart, I can explode it. To do that, I click on the chart and select Design | Change Chart Type. This opens the Change Chart Type dialog box shown in Figure 3-14. Selecting the pie chart subtype that separates the slices (Exploded Pie) creates the chart in Figure 3-15.

				
					Figure 3-14: The Change Chart Type dialog box.

				

				[image: 454060-fg0314.eps]

				Whenever you set up a pie graph — whether intact or exploded — always keep in mind . . . .

				
					Figure 3-15: The exploded version of Figure 3-9.
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				A word from the wise

				Social commentator, raconteur, and former baseball player Yogi Berra once went to a restaurant and ordered a whole pizza. 

				“How many slices should I cut,” asked the waitress, “four or eight?” 

				 “Better make it four,” said Yogi, “I’m not hungry enough to eat eight.”

				Yogi’s insightful analysis leads to a useful guideline about pie graphs: They’re more digestible if they have fewer slices. If you cut a pie graph too fine, you’re likely to leave your audience with information overload.

				Drawing the Line

				In the preceding example, I focused on one column of data from Table 3-1. In this one, I focus on one row. The idea is to trace the progress of one space-related industry across the years 1990–1994. In this example, I graph the revenues from Satellite Services. The final product, shown on its own page, is Figure 3-16.

				
					Figure 3-16: A line graph of the second Row of Data in Table 3-1.

				

				[image: 454060-fg0316.tif]

				A line graph is a good way to show change over time, when you aren’t dealing with too many data series. If you try to graph all six industries on one line graph, it begins to look like spaghetti. 

				How do you create a graph like Figure 3-16? Follow along:

				1. Enter your data into a worksheet.

				 Once again, already done.

				2. Select the data that go into the chart.

				 For this example, that’s cells B3 through F3.

				 Whoa! Did I forget something? What about that little trick I showed you before where you hold down the CTRL key and select additional cells? Couldn’t I do that and select the top row of years for the x-axis?

				 Nope. Not this time. If I do that, Excel thinks 1990, 1991, 1992, 1993, and 1994 are just another series of data points to plot on the graph. I’ll show you another way to put those years on the x-axis.

				3. In Charts area of the Insert tab, select the chart type.

				 This time, it’s Insert | Line and then the fourth subtype, Line with Markers. This creates the chart in Figure 3-17.

				
					Figure 3-17: Insert | Line | Line With Markers creates the line chart.
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				4. Modify the chart. 

				 The line on the chart is a little hard to see. Selecting Design | Chart Styles and the leftmost option makes the line darker.

				 Next, I added the titles for the chart and for the axes. Clicking the down arrow of Design | Chart Layouts opens a box with 12 possibilities. Selecting the tenth one creates text boxes for the titles on the chart.

				 I still have to put the years on the x-axis. To do this, I right-clicked inside the chart to open the menu in Figure 3-18. 

				
					Figure 3-18: Right-clicking inside the chart opens this menu.
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				 Clicking Select Data opens the Select Data Source dialog box. (See Figure 3-19.) In the box labeled Horizontal (Category) Axis Labels, clicking the Edit button opens the Axis Labels dialog box (Figure 3-20). A blinking cursor in the Axis label range box shows it’s ready for business. Selecting cells B1 through F1 and clicking OK closes this dialog box. Clicking OK closes the Select Source dialog box and puts the years on the x-axis.

				
					Figure 3-19: The Select Source dialog box.
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				 One more modification completes the graph. The legend (showing “Series 1”) isn’t necessary. Right-click on it and choose Delete from the pop-up menu.

				
					Figure 3-20: The Axis Labels dialog box.
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				Passing the Bar 

				Excel’s bar chart is a column chart laid on its side. This is the one that reverses the horizontal-vertical convention. Here, the vertical axis holds the independent variable, and it’s referred to as the x-axis. The horizontal axis is the y-axis and it tracks the dependent variable.

				When would you use the bar graph? This type of graph fits the bill when you want to make a point about reaching a goal, or about the inequities in attaining one. 

				Table 3-2 shows the data on (what I feel, anyway) is an important social issue. The data, from the U.S. Census Bureau (via the U.S. Statistical Abstract), are for the year 2000. Percent means the percentage of children in each income group.

				
					
						
								
								Table 3-2 Children’s Use of the Internet at Home (2000)

							
						

						
								
								Family Income

							
								
								Percent 

							
						

						
								
								Under $15,000

							
								
								7.7

							
						

						
								
								$15,000-$19,999

							
								
								12.9

							
						

						
								
								$20,000-$24,999

							
								
								15.2

							
						

						
								
								$25,000-$34,999

							
								
								21.0

							
						

						
								
								$35,000-$49,999

							
								
								31.8

							
						

						
								
								$50,000-$74,999

							
								
								39.9

							
						

						
								
								Over $75,000

							
								
								51.7

							
						

					
				

				The numbers in the table are pretty dramatic. Casting them into a bar chart renders them even more so, as Figure 3-21 shows.

				
					Figure 3-21: A bar chart of the data in Table 3-2.
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				To create this graph, follow these steps:

				1. Enter your data into a worksheet.

				 Figure 3-22 shows the data entered into a worksheet.

				
					Figure 3-22: Table 3-2 data in a worksheet.
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				2. Select the data that go into the chart.

				 For this example, the data are cells A1 through B8.

				3. In the Charts area of the Insert tab, select the chart type.

				 I clicked the down arrow for Insert | Bar and selected the first subtype (Clustered Bar). The result appears in Figure 3-23. The title is wrong and the legend is unnecessary, but I deal with that in Step 4.

				
					Figure 3-23: The Initial Excel bar chart. 
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				4. Modify the chart.

				 The first modification is to select a layout. This is a little confusing, because Design | Chart Layouts holds the desired look, rather than a ribbon area within the Layout tab. Go figure. The trick is to select a layout that puts text boxes for the titles onto the graph. The option that does this (Layout 8) is shown selected in Figure 3-24. (The other way to do this is with Layout | Labels as I showed you earlier.)

				
					Figure 3-24: The layout for adding axis titles and chart title to the bar chart.
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				 After entering the labels, I deleted the legend. Then I darkened the bars via Design | Chart Styles. Right-clicking on each label brings up the menu for increasing the font size. 

				The Plot Thickens

				You use an important statistical technique called linear regression to determine the relationship between one variable, x, and another variable, y. For more information on linear regression, see Chapter 14.

				The basis of the technique is a graph that shows individuals measured on both x and y. The graph represents each individual as a point. Because the points seem to scatter around the graph, the graph is called a scatterplot.

				Suppose you’re trying to find out how well a test of aptitude for sales predicts salespeople’s productivity. You administer the test to a sample of salespersons and you tabulate how much money they make in commissions over a two-month period. Each person’s pair of scores (test score and commissions) locates him or her within the scatterplot. 

				To create a scatterplot, follow the steps:

				1. Enter your data into a worksheet. 

				 Figure 3-25 shows the entered data.

				
					Figure 3-25: Scatterplot data.
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				2. Select the data that go into the chart.

				 Figure 3-25 shows the selected cells — B2 through C21. (Including B1 creates the same chart, but with an incorrect title.) The cells in Column A are just placeholders that organize the data.

				3. In the Charts area of the Insert tab, select the chart type.

				 I chose the first subtype of Insert | Scatter, resulting in the chart shown in Figure 3-26.

				
					Figure 3-26: The initial scatterplot.
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				4. Modify the chart.

				 Clicking Design | Chart Layouts and selecting the first layout puts the text box on the chart for each title. I typed the title for the chart and the titles for the axes and then deleted the legend. The result is the scatterplot in Figure 3-27.

				
					Figure 3-27: The almost-finished scatterplot.
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				For the other graphs, that would just about do it, but this one’s special. Right-clicking any of the points in the scatterplot opens the pop-up menu in Figure 3-28.

				
					Figure 3-28: Right-clicking any point on the scatterplot opens this menu.
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				Selecting Add Trendline opens the Format Trendline dialog box. I selected the Linear radio button and clicked the two bottom checkboxes. They’re labeled Display Equation on Chart and Display R-Squared Value on Chart (Figure 3-29).

				
					Figure 3-29: The Format Trendline dialog box.
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				Clicking OK closes the Format Trendline dialog box. A couple of additional items are now on the scatterplot, as Figure 3-30 shows. A line passes through the points. Excel refers to it as a trendline, but it’s really called a regression line. A couple of equations are there, too. (For clarity, I dragged them from their original locations.) What do they mean? What are those numbers all about?

				You’ll just have to read Chapter 14 to find out.

				
					Figure 3-30: The scatterplot, with additional information.

				

				[image: 454060-fg0330.tif]

			

		

	


End of sample
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